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July has National
Cheesecake Day

July 30th is
National
Cheesecake
Day.

Did you know?

A small cheesecake shop
opened in Detroit in the late
1940s by Oscar and Evelyn
Overton. Although the Over-
tons eventually gave up that
shop in order to raise their
children (with Evelyn con-
tinuing to supply local res-
taurants with cheesecakes
she baked in her basement
kitchen), they moved to Cali-
fornia in 1971 and opened a
"Cheesecake Factory" bak-
ery in Los Angeles. The
Overtons' bakery business
grew over the next several
years to the point that they
were distributing a variety of
cheesecakes and other des-
serts to hundreds of ac-
counts, and in 1978 their son
David opened the first
"Cheesecake Factory" res-
taurant in Beverly Hills. From
that initial bakery and restau-
rant Cheesecake Factory
chain has grown to 143 loca-
tions in 34 states coast to
coast (including Hawaii and
the District of Columbia).

My Favorite? Key Lime
Cheesecake—Yum!

Till next month,

Summer Time Fun!

Odds and Ends from Orion:

e There's a bumper crop expected for corn this year as well as a
bumper crop of summertime fun. We've been using the pool al-
most everyday to cool off and it's been great fun for the family!

e Please mark your calendar for the upcoming summer holiday. We will be closed
on Monday September 6th for the Labor Day weekend. Please let us know if you
have any big software-IT projects planned for that weekend (so we can be avalil-
able if you need us).

e Forthose on Level 4.2, Level 4.3 and Level 4.4. The latest service pack release for
each level is as follows. Level 4.2 is on service update number 26, 4.3 is on ser-
vice update number 19 and 4.4 is on service update 2. These updates are avail-
able to you as part of your Client Care subscription with Sage. If you need help
installing any of the service updates or have any questions, please give us a call.

Till Next Month,

Ll
Sage ERP MAS 90 and 200 941 Update for HIRE Act s&% IRS .gov

In Case you missed this from last month’s emailed bulletin. Here is the information on the
changes from the HIRE Act.

The HIRE Act encourages companies to hire unemployed workers by exempting certain wages
from the employer's portion of Social Security taxes (payroll tax exemption), and by providing
employers with a business tax credit if new hires are retained for at least 52 consecutive weeks.
For an employer to receive these tax benefits, the unemployed worker must be a "qualified indi-
vidual". A qualified individual is anyone who:

e  Begins work for a qualified employer after Feb. 3, 2010 and before Jan. 1, 2011

e  Certifies by signed affidavit (under penalties of perjury) that he has not been employed
for more than 40 hours during the 60-day period ending on the date the employment
begins

e Is not employed to replace another employee of the employer unless that former em-
ployee separated from employment voluntarily, or for cause

e Is not related to the employer (under rules similar to those for related individuals in IRC
851(i) ) [ IRC §3111(d)(1) ]

The IRS has drafted Form W-11, Hiring Incentives to Restore Employment (HIRE) Act Employee
Affidavit, to help employers meet the second requirement under "qualified individual". The form
instructions state that the employee must complete and sign the affidavit, or a similar statement,
under penalties of perjury, for an employer to receive the tax benefits under the HIRE Act. The
Form W-11 requires qualified individuals to provide their name, Social Security Number (SSN),
first date of employment, and name of the employer.



http://www.irs.gov/newsroom/
article/0,,id=221036,00.html/
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What's new in MAS 90 Product Update 4.40.0.2!

The second Sage MAS 90 and 200 4.4 Product Update — 4.40.0.2 — Delivering additional features and func-
tionality and product enhancements as an additional on-plan customer benefit, Product Update 2 delivers
value across the system and in arange of modules including Bank Reconciliation, Accounts Payable, and
Paperless Office. Many of these enhancements are the result of incorporating the main features and func-
tionality of select Extended Solutions into the core product, and others are totally new customer-requested
features that solve pain points.

Bank Reconciliation - Automatically Reconcile Checks (similar to BR-1005)

Efficiently and automatically reconcile check information you download from your financial
institution. Use the new Auto Check Reconciliation Wizard to create the proper check setting
format for your financial institution per their specifications. Or, your Business Partner can
configure the setting in their office, export the file, and then import it into your system.

Bank Reconciliation — Enforce Tighter Controls over Bank Reconciliation Adjusting Entries
(New)

Further refine and control who is allowed to enter modifications to the Current Balance in
Bank Reconciliation using a new option in Role Maintenance, Common Information. For banks
defined in Bank Code Maintenance, you can specify the users who are allowed to access and
make adjusting balance entries.

Bank Reconciliation — Enter Checks, Deposits, and Adjustments On-the-Fly (New)

In Reconcile Bank, you have instant access to enter checks, deposits, and adjustments through
a quick link button to bring you directly into Check or Deposit and Adjustment Entry for that
bank — without navigating all the way back to the main menu to open a data entry screen, or
exiting your Reconcile Bank screen.

Bank Reconciliation - Conveniently Use Recalculate Outstanding Entries Totals Utility
(New)

To improve workflow, the Recalculate Outstanding Entries Totals Utility is available from the
Bank Reconciliation module, via the Utilities Menu. This utility allows you to recalculate the
totals of all outstanding check, deposit, and adjustment entries that have not been marked as
cleared.

Bank Reconciliation - Positive Pay Export (similar to BR-1004)

Deter check fraud using the new Positive Pay features in the Bank Reconciliation module.
Positive Pay assists your financial institution to monitor against suspicious check activity
using a file you create and submit for comparison and verification. The Positive Pay file
contains key information, such as check numbers and dollar amounts, to identify only the
checks you have issued and authorized for payment. Components of the check must match
exactly, or the check will not be paid by the financial institution. Checks sent to the bank using
Positive Pay are identified with an Exported check box In Check, Deposit and Adjustment
Entry.

Continued Next Page -
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MAS90 and MAS200 Individual Program Fixes! - continued

Bank Reconciliation - Positive Pay Export Wizard (Vew/

Use the new Positive Pay Export Wizard to create the proper export file format specified by
your Financial institution, for comparison of the file you send with the checks that are
presented for payment. To help you understand and translate formatting requirements, we've
included a reference document that outlines the most commonly used field formatting and
export details required by financial institutions. And, if your financial institution updates their
specified file format, you can also use the Positive Pay Export Wizard to make the necessary
changes without depending on a programmer to re-format it For you.

Bank Reconciliation - Expanded Comment Field (Vew/
In Check, Deposit and Adjustment Entry, the Comment field has been expanded to 2048
characters to allow you to add information to track why the adjustment was made.

Accounts Payable — ACH Electronic Payments (similar to AP-1063)

Increase your efficiencies, improve your cash management, reduce operating costs and lessen
the risk of lost or stolen checks by paying vendors electronically using an ACH file created
from the Accounts Payable module. Enable ACH electronic payments, define how they will be
handled by your company, and the type of information that will be transmitted to your
financial institution.

You have the flexibility to select and set up one or more financial institution(s) For your
electronic payments, and for each one you select, define the format and layout of the ACH file.
The feature includes pre-note functionality, and flexibility in your electronic payment
distribution, including options to allocate amounts between one or more accounts.

ACH information on processed payments, historical information and vendors paid
electronically is available on AP Reports. They can include auto checks, manual checks, voided
checks, reversals, credit card transfers, electronic payments, wire transfer information in any
combination.

Paperless OFfice — Accounts Payable Checks, Extended Stubs, and Electronic Payment
Remittance Advices (similar to AP-1095)

Save time, money, and the environment by utilizing Paperless Office to process, send and
retain electronic copies of Accounts Payable checks and extended stubs, and remittance
advices created for ACH Electronic Payments in PDF format. Add a unique message to include
when emailing or faxing electronic remittances. The PDFs you create are also available to e-
mail and fax, retrieve and archive. Easily access PDFs using the Vendor Viewer from Paperless
Office or the Checks panel in Vendor Maintenance Inquiry.

Very Important Note: This update comes with a utility to do a Product Up-
date Pre-Installation Scan to identify data integrity issues during the installa-
6’(‘@ tion. Determine your data’s health during the scan, and utilize Sage ERP
. N MAS 90 and 200 Library Master Utilities for corrections as needed. The scan
; identifies suspect data and the accompanying log provides the necessary
[ steps to address issues prior to the product update installation, streamlining

the update process. Conveniently add this maintenance step to your normal
process whenever you install a new product update.

Please contact us if you need assistance with your product update.



Windows Tip - 4 quick tips for using Excel - Enhance vour spreadsheets with these helpful hints

Locking columns and rows

If you want to freeze a row of titles or categories so that you can keep them in sight as you enter data further down
your spreadsheet, Microsoft Excel has a handy Freeze Panes function. "l keep the results budget projections
locked in one pane so | can see the bottom-line impact of expense and revenue forecasts | make in another pane”
say many excel users. To lock a pane, use your mouse to select the row below or the column to the right of where
you want to freeze. On the Window menu, click Freeze Panes.

Forcing line breaks
If you enter a lot of data into one cell and then move to a new cell and enter further data, you may notice that the
original information gets covered up. The solution is to force line breaks. To do this:

Click on a cell.

Type the first line.

Press Alt + Enter.

Type the second line.

Repeat step 3 to enter additional lines.
Press Enter when finished.

Creating a drop-down menu
You can create a drop-down menus that save typing time. To create a drop-down menu:

Open a worksheet and label your menu (Days for example) in the top cell of a column.

Enter data (days of the week, in this case) in the cells below the label (such as A2 to A8).

Highlight the list, including the label.

Click the Insert menu, then click Name, and then Define.

In the box under Names in workbook you will see the name of the range (Days). In the Refers to box, it
should list "=Sheet1!" followed by the range (=Sheet1!$A$1:$A$8).

Click Add and then OK.

Select any cell or range of cells in which you want to enter data.

Click the Data menu and then Validation.

From the Allow drop-down menu, select List. In Source, type
Make sure that the In-cell dropdown box is checked.

Click one of the cells you highlighted to see your drop-down menu. Choose the item you want to enter in
the active cell. Enter data from your list, in any order, in each of the cells you selected.

and the name of your range (=Days).

Converting complex calculations into handy charts

Microsoft Excel can also be used to convert calculations into charts. To create a pie chart that shows how much of
your income you project to spend on a category-by-category basis, for example, enter spending categories in one
column (like Al through A5) and your estimated expenditures for each category in an adjacent column (B1 through
B5).

Highlight the column of expenditures. On the Insert menu, click Chart, then Pie, then Next, and then Next again.
Select where you'd like the legend to display by clicking the Titles tab. In the Chart title box, enter your title (Family
Budget). Then click the Data Labels tab, check the Percentage box, and then click Next.

Insert the chart in a new sheet or as an object in your existing workbook. Either way, whenever you update your
data (as you add actual expenditures, for instance) the chart will change and you will see how much you spend by
category and the percentage of your total budget that each category represents.

We encourage you to provide us with your feedback, comments and suggestions on how we can better serve
your business needs. Contact us at 248-893- 1060 or email to jimsteele@orionbas.com




